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Microsoft Office 2016
Microsoft Office is a suite of productivity applications that share 
common features and approaches. There have been many versions, 
but the latest version, released in September 2015, is Office 2016.

There are various “Office 2016” retail editions:

Office Home & Student 2016 edition contains:  

• Excel 2016   Spreadsheet and data manager 

• PowerPoint 2016  Presentations and slide shows 

• OneNote 2016  For taking and collating notes 

• Word 2016   Text editor and word processor

Office Home & Business 2016 edition contains all of the apps in 
the Home & Student edition, plus:  

• Outlook 2016  Electronic mail and calendar

Office Professional 2016 edition contains all applications found 
in the Home & Business edition, plus two additional apps:  

• Access 2016  Database manager 

• Publisher 2016  Professional document creation

There are also various “Office 365” subscription editions:

Office 365 Personal edition contains all the apps (Excel, 
PowerPoint, OneNote, Word, Outlook, Access and Publisher) for 
one individual – licensed for 1 PC, 1 tablet, and 1 phone.

Office 365 Home edition also contains all the apps, but for an 
entire household – licensed for 5 PCs, 5 tablets, and 5 phones.

Office 365 Business edition contains all apps except Access, plus: 

• OneDrive for Business Online file storage and sharing

Office 365 Business Premium edition contains all the apps found in 
Office 365 Business (including OneDrive), plus three additional apps:  

• Microsoft Exchange Hosted messaging solution 

• SharePoint Online  Collaboration web services 

• Skype for Business  Hosted communications service

Office 365 Enterprise editions contain all applications found in 
the Office 365 Business Premium edition but provide additional 
security and information management tools.

There are estimated to 
be over 1.2 Billion users 
of Microsoft Office.

Office Online provides 
free web-based versions 
of the common apps, 
and Office Education 
provides extra special 
features for schools, 
teachers, and students.

In this book, the New 
icon pictured above is 
used to highlight new 
or enhanced features in 
Office 2016.
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The Ribbon interface also provides 
extended ScreenTips that can 
contain text, images, and links to 
more help. The tips display as you 
move the mouse pointer over an 
option, and describe the functions 
or give keyboard shortcuts.

Whichever edition of Office 2016 or Office 365 that you have, 
the applications they provide will all feature the graphical user 
interface based on the Ribbon. This replaced the menus and 
toolbars that were the essence of earlier versions of Office.

The Ribbon contains command buttons and icons, organized in 
a set of tabs, each containing groups of commands associated 
with specific functions. The purpose is to make the relevant 
features more intuitive, and more readily available. This allows 
you to concentrate on the tasks you want to perform, rather than 
the details of how you will carry out the activities. Some tabs 
appear only when certain objects are selected. These are known 
as “contextual” tabs, and provide functions that are specific to the 
selected object. For example, when you select an inserted image, the 
Picture Tools, Format tab and its command groups are displayed.

Ribbon Technology

This result-oriented 
user interface was first 
introduced in Office 
2007, and now appears 
in all the applications in 
Office 2016.

For systems with touch-
enabled monitors, Office 
2016 offers a Touch 
Mode ribbon with larger 
and more widely spaced 
icons (see page 14).
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What’s Needed
To use Microsoft Office 2016, you will need at least the following 
components in your computer:

• 1GHz processor (32-bit or 64-bit)

• 2GB RAM memory

• 3GB available disk space

• 1280 × 800 or larger 
resolution monitor

• DirectX 10 graphics card

• Windows 10, 8/8.1, 7 SP1, 
or Windows Server 10, 2012 R2, 2012, 2008 R2

Some functions will have additional requirements, for example:

• Touch-enabled monitor for controlling the system

• Internet connection for online help

• CD-ROM or DVD drive for install, backup and data storage

If your computer is running Windows 8, 8.1 or 10, the system 
specifications will meet or exceed requirements for Office 2016.

These system properties 
are for the PC used 
in this book, which is 
running Windows 10 
Pro. However, the tasks 
and topics covered will 
generally apply to any 
supported operating 
system environment.

These are the minimum 
requirements. A higher-
speed processor, with 
additional memory will 
produce faster results.
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Installing Office 2016
You can buy your preferred version of Microsoft Office 2016 
in disk format from a retail source or download it directly from 
Microsoft. Windows 10 provides a default “Get Office” item on 
the Start menu that launches your web browser at the Office 
download page products.office.com. Here, you can select one of 
the Office 365 subscription-based versions of Microsoft Office 
2016. These provide fully installed Office apps that work across 
multiple devices and are continuously upgraded – so are always up 
to date. For example, you might choose the Office 365 Personal 
version, which lets you use Office on one PC, one tablet, and one 
phone. This also gives you a massive 1TB of storage for one user.

To compare the various 
versions of Office visit 
products.office.com/
en-us/buy/compare-
microsoft-office-
products

l1 Click the Get Office tile or Start menu 
item – to launch your web browser

l2 Select your version then enter the 
purchase details – to begin installation

l3 Take a 
break until 
the Office 
completion 
dialog appears

Microsoft is eager to 
encourage adoption of 
the subscription versions 
– Office 365 Personal 
edition also includes 60 
minutes per month of 
Skype calls to cellphones 
and landlines.
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Start an Application
With Microsoft Office 2016 installed under Windows 10, you 
have a number of ways to launch the Office apps:

l1 The installation of Office should have added colored icons 
for various Office apps onto the Windows Desktop taskbar. 
Click the blue ‘W’ icon to launch the Word 2016 app

l2 In either Desktop or 
Tablet mode, click or 
tap the Start button, 
then choose All apps

l3 Now, scroll down the 
A-Z list to the W 
category heading

l4 Choose the Word 
2016 item to launch 
the Word 2016 app

These options are 
available for the 
Windows 10 operating 
system.

You can right-click the 
Word 2016 item on the 
All apps list and select 
Pin to taskbar if the 
Word icon isn’t already 
visible on the taskbar.
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…cont’d

l5 In the taskbar 
Search box, type 
“word” to search 
for the Word app 
on your system

l6 Now, click or tap 
the Word 2016 
item from the 
search results to 
launch the Word 
2016 app

You can right-click the 
Word 2016 item on the 
All apps list, and select 
Pin to Start to add a 
tile to the Tablet mode 
Start screen and Desktop 
mode Start group.

Cortana is new in 
Windows 10 but 
performance may vary by 
region. If Cortana is not 
working or enabled in 
your country, try setting 
your region to “United 
States” in Settings, 
Time & language, 
Region & language.

l7 Say “Hey Cortana” 
into your system 
microphone to 
wake up your 
Personal Digital 
Assistant

l8 Now say “start 
Word” into the 
microphone to 
launch the Word 
2016 app
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l3 Click the Touch/Mouse Mode 
button on the Quick Access 
Toolbar, and then select Touch

l4 The expanded Ribbon is displayed

Application Start

l1 Select an Office 2016 application item such as Word, 
using any of the methods described on the previous pages, 
to display that application’s Start screen

The Touch/Mouse 
Mode button appears 
by default when you 
have a touch-enabled 
monitor. To add it if 
not displayed, click 
the Customize Quick 
Access Toolbar button 
and then select Touch/
Mouse Mode. You can 
then display the enlarged 
Ribbon on a standard 
monitor.

Document-based Office 
applications open at the 
Start screen with the 
Recent list and various 
document templates.

l2 Select Blank document to begin a new editing session
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The Application Window
When you start an Office application such as Excel, PowerPoint 
or Word, the program window is displayed with a blank document 
named “Book1”, “Presentation1”, or “Document1” respectively. 
Using Word for example, parts of the application window include:

Backstage    Quick Access Toolbar   Document name   Tabs 
(File tab) 

Status bar   Horizontal scroll area   View buttons   Zoom level

 
When you have updated your document and want to save your 
progress so far, click File to display the Backstage command 
screen and then select Save to name and save the document. You 
can save it in your OneDrive (see page 16) or on your computer.

“Tell Me” Help box 
Ribbon Display options

Minimize/Restore/Close

Ribbon Command icons 
(display lists or galleries)

Collapse the Ribbon

Group launch button 
(shows dialog box)

Vertical scroll area

From Backstage you can 
select Info for details 
about your document, 
or New to start another 
document, or Open 
to display an existing 
document. There are 
also printing and sharing 
options provided.

File commands   Save locations   Browse the            Recent Folders 
    selected location 

The Tell Me Help box 
is new in Office 2016 
and is available in Word, 
Excel, Outlook and 
PowerPoint.
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Your OneDrive
To save documents to your OneDrive online storage:

l1 Select File, Save As, then click the 
OneDrive button

l2 Confirm or amend the document name then choose the 
appropriate folder, e.g. Documents

l3 Click Save to upload the document and save it to your 
OneDrive folder

l4 To access your OneDrive from a browser, go online to 
onedrive.live.com, and sign in if prompted

OneDrive lets you access 
and edit your documents 
from any computer 
where you sign in with 
the same Microsoft 
Account. You can also 
access your OneDrive 
and documents from a 
web browser.

OneDrive was previously 
known as SkyDrive. 
When you set up a 
Microsoft Account to 
sign in to Windows, 
you are assigned an 
allowance of up to 
15GB online storage 
which is managed on 
the Microsoft OneDrive 
server (see also page 
222). An Office 365 
subscription gives you a 
further 1TB of storage 
(correct at the time of 
printing).
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…cont’d

If you are running Windows 7 or 8, you can download OneDrive 
for Windows to store your Office 2016 documents. You can also 
download OneDrive for other operating systems, such as Android, 
to allow ready access to your documents across all your devices.

l1 Launch your web browser and navigate to the OneDrive 
home page at onedrive.live.com and click Download

l3 Click the Sign in button, if you already have a Microsoft 
Account, or click the Sign up button to create an account

l4 The application is downloaded and installed, and the 
OneDrive is created where you can save your documents

OneDrive comes pre-
installed on Windows 10.

After installation you’ll 
be offered the option to 
sync all of your files and 
folders on OneDrive, or 
choose selected folders 
to sync.

l2 Select the operating system you require – for example, 
choose Windows if you are running Windows 7 or 8
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With the Ribbon interface, you can immediately see the full effect 
of format options, such as fonts and styles, on your document by 
simply pointing to the proposed change. For example, to see font 
formatting changes:

l1 Highlight the text that you may wish to change, then 
select the Home tab

Live Preview

l2 Click the arrow next to the Font box and move the 
mouse pointer over the fonts you’d like to preview

l3 Click the font you want to apply to the 
text, or press Esc to close the options

l4 Similarly, you can preview Text Effects, 
Highlight Colors and Font Colors

In earlier versions, you 
would be shown a 
preview of the new font 
or style using a small 
amount of sample text. 
Office 2016 displays full 
previews.

The selected text is 
temporarily altered 
to show the font (or 
the font size, color or 
highlight) you point to.
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The Ribbon takes up a significant amount of the window space, 
especially when you have a lower-resolution display. To hide it:

Working with the Ribbon

Hold down the Alt key 
and press the keys in 
sequence for a two-
letter shortcut, such as 
Alt + FS (Font Size), and 
press Esc to go back up 
a level.

l5 Press Alt + shortcut key, for example Alt + H to select 
Home and display the Ribbon and shortcuts for that tab

l2 The Quick Access Toolbar and the Tab bar will still be 
displayed while the Ribbon is minimized

l3 The Ribbon reappears temporarily when you click one of 
the tabs, so you can select the required command

l4 Alternatively, press and release the Alt key to display 
keyboard shortcuts for the tabs

l1 Click the Collapse the Ribbon 
button (see page 15), or   
 
Right-click the tab bar and 
select Collapse the Ribbon You can also select 

Ribbon Display 
Options on the 
Windows Titlebar and 
choose Show Tabs 
to hide the Ribbon, 
or Show Tabs and 
Commands to reveal 
the Ribbon.
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Quick Access Toolbar
The Quick Access Toolbar contains a set of commands that are 
independent of the selected tab. There are five buttons initially:

Save   Undo   Repeat/Redo     Touch/Mouse   Customize 
                 last command         Mode         Quick Access Toolbar 

l1 Click the Save button to save the current contents of the 
document to your OneDrive, or to the drive on your PC

l2 Click Repeat to carry out the last action again, or click 
Undo to reverse the last action, and click again to reverse 
the previous actions in turn

l3 When you have pressed Undo, the Repeat 
button changes to become the Redo button, 
which will re-apply in turn the actions that 
you have reversed

l4 Click the Customize button to add 
or remove icons, using the shortlist of 
frequently-referenced commands

l5 Click More Commands... to display 
the full list of commands, then add and 
remove entries as desired

You can also click the 
File tab, then select the 
application Options and 
select Quick Access 
Toolbar to display this 
dialog box.

You can right-click any 
command on the Ribbon 
and select Add to 
Quick Access Toolbar.

The Save As dialog will 
open the first time you 
press the Save button 
for a new document.
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The files you create using the Office applications will be office 
documents of various types, including:

•Word document  Formatted text and graphics  

•Publisher publication Flyers and brochures   

•Excel worksheet  Spreadsheets and data lists  

•PowerPoint presentation Presentations and slide shows 

Each item will be a separate file. Typically, these may be saved in 
your OneDrive Documents folder (or locally on your computer).

l1 To review your files, open File Explorer and select your 
OneDrive Documents folder

Office Document Types

l2 This shows the files as large icons. For other styles, click 
the View tab and select, for example, Details, to show the 
file information including date modified, size, and type

In some applications, 
groups of related items 
are stored together in a 
specially structured file,  
for example, data tables, 
queries, and reports in 
an Access database.

You can specify another 
folder or sub-folder to 
organize particular sets 
of documents.
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File Extensions
To see the file extensions that are associated with the various 
document types:

l1 In File Explorer, select the 
View tab and in the Show/
Hide section of the Ribbon 
click the box labeled File 
name extensions

l2 View the contents of your library folder

l3 The file type will be shown, along with the file name, 
whichever folder view you choose 

You can also change 
File Explorer Options 
in the Control Panel, 
under Appearance and 
Personalization.

Files saved in Office 
2016 use OpenXML 
formats and extensions, 
for example .docx and 
.xlsx. Older Office files 
will have file types such 
as .doc and .xls.
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Office 2016 will open documents created in previous versions of 
Office applications, for example .doc (Word) or .xls (Excel).

l1 Click the File tab and select Open, then click the down 
arrow for the list of document types supported

Compatibility Mode

l2 Choose the document type, “Word 97-2003” for example, 
then select the specific name, e.g. Old Format.doc

l3 Documents created in previous versions (including .docx 
files from Word 2010) are opened in Compatibility Mode

Compatibility Mode 
prevents the use of new 
or enhanced features, 
so the documents 
can continue to be 
used by systems with 
older versions of the  
applications.

You may need to 
save documents in 
Compatibility Mode, as 
some users you wish to 
share files with may not 
have Office 2016.
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If you have opened a document in Compatibility Mode, you can 
convert it to the standard Office 2016 format.

Convert to Office 2016

With Save As, you have 
the option to change 
the file name, and the 
location for the new 
document.

Converting will create a 
file of the same name, 
but with the new Office 
2016 format extension. 
The original file will be 
deleted.

You can also click the 
File tab, select Save As, 
and choose the standard 
Office format (e.g. Word 
Document) to carry out 
the conversion.

l4 To retain the original while creating a new file in Office 
2016 format, select File, Save As, then click Save

l3 To replace the original file, 
select File and then Save – 
see the file extension change 
in the Word title bar to the 
new .docx file type

l1 Select the File tab and Info, 
then the Convert button 
 

l2 Click OK to confirm, and the 
file type will be amended
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